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Start Search City
You can start Search City once Windows is already running.

To Start Search City
¨ Double-click the Search City group and icon.



Search City's Main Window
When you start Search City, you see Search City's main window or workplace empty. 
The menu bar is active so you can choose commands.
When you open a group of files,    the other elements from Search City's main window will 
appear and become available.
The title bar displays "Search City" and the name of the active group.
The menu bar contains a list of menus. You open menus and then choose commands from 
them to instruct Search City to perform actions.
With the mouse, the toolbar provides instant access to all Subject and History related 
features.
The query bar helps you quickly perform your searches.
The status bar provides information about the active file or document.
The navigation bar contains buttons used to move among the group's files in order to 
review the results of a query.



Quit Search City
Once you have finished working with Search City, you must quit the application.

To Quit Search City
¨ Choose the Quit command from the File menu.
-Or-

Double-click the Control menu box in the upper left corner of the screen.
The Search City screen automatically closes and the Windows Application Manager takes 
control.



Open a Group
You must open a group before executing searches. The group will appear in the text area.

A group is a user defined set of files used to search information. That is, it represents 
the search universe you will work with. 

To open any existing group
1. From the File menu, choose Open.

Search City displays the Open Group dialog box.
2. In the File Name box, type the name of the file you want to open.
-Or- 

Click the name of the group you want in the group list.
Search City only recognizes as groups the filenames with extension .SCG.
To see a list of all files in a drive or directory, type *.* in the File Name box.    On the 
contrary, Search City will only display files with .SCG    extension, as indicated    in the 
same box.

If you don't see    the name of    the group you want,    do one of the following:
· If the group is in a different subdirectory, double-click the    directory in the 

Directories box.
-Or-

If the group is in a different drive, click the arrow in the Drives box and then 
click the drive letter.

3. Choose the OK button.
The dialog box closes and the group appears in the text area of Search City's main 
window.
Search City is now ready to perform your searches.
When the Use Default Directory option from the Options menu is selected, the Open 
Group dialog box is always displayed with the default directory selected.



Close a Group
If you're ready to begin work on another document or if you're finished working, you can 
close the active group.

To close    a group
¨ From the File menu, choose Close.

The current group closes and the Search City's main window becomes empty. You can 
now open another group or quit the application.



Create a Group and Define its Properties
Search City works on the basis of groups in order to simplify the definition of the search 
universe, that is, the texts involved in your searches. A simple procedure lets you determine 
different sets of files (groups), defined according to a wide range of information 
management criteria.
You can create groups to suit your specific text retrieval requirements, taking into account    
the type of searches you will execute as well as the texts involved. 
Groups can contain plain files or files divided into documents and fields to form a text 
database.
When creating a group, you define the following basic properties:
· the set of files which make up the group,
· the filters used to transform the text involved in searches,
· optionally, the text database structure of documents and fields.
The creation procedure consists of three steps. 
You first create the group definition, indicating its basic characteristics (group name, path, 
filters applied and text database structure, if necessary). 
Then, you add files to the group. 
When creating a text database, it is simple and flexible to include document files. In the 
group definition, you specify all possible characters used to separate documents and fields. 
Thanks to this feature, you can reassemble in the same database files containing different 
separation characters. Furthermore, files can have any number of documents (from one on) 
and documents may have a variable number of fields (from zero to the total number of fields
specified for the text database).
Once files have been added, you must index the group,    which corresponds to the final 
stage of the group creation procedure. When you index a group, Search City is able to work 
with it. Then you are ready to execute any of the search operations provided by the 
application.
For more information see:
Create a File Group Definition
Create a Text Database Group Definition
Add Files to the New Group



Create a File Group Definition
The first step of the creation procedure is to establish a general group definition.

To create a file group definition
1.  From the File menu, choose New.

Search City opens the New Group dialog box.
2. Choose the OK button.

Search City displays the Create File Group dialog box.
3. To define the group filename:

· Click any part of the File Name box and type the group filename.    Optionally,
you can specify a    path.
The filename can include a maximum of 8 alphanumeric characters, plus the file path, 
if specified.
Groups must have a .SCG extension. If not specified, Search City will add it for you.
If the Use Default Directory option from the Options menu is active, the new group will 
automatically be saved in C:\SEARCHIT. 
If this option is not active or if you want to save the new group in another directory, 
you must specify the complete path in the File Name box.

-Or-
Choose the Browse button to define the filename and its path using the 
Browse dialog box
Double-click in a lower level directory to open it or in a higher level directory to move 
up in the directory hierarchy. When the Directories: message indicates the required 
path, type a filename for the new group in the File Name box and choose the OK 
button to validate the dialog box information.

4. Type a sentence in the Description box so you    can easily identify the new 
group. 
This is optional information. Nevertheless, it is very handy if you create several groups 
with similar filenames. 
The description text can have up to 255 characters.

5. In the Filters box, select the Character Filter you want to apply to the group.
To do so, click the arrow and select any character filter from the    list of available 
character filters.
The    group must have a    character filter.

6. You can select a Synonym Filter and/or a Stopword Filter for the group.
The synonym and stopword filter boxes display None by default, since these are optional 
filters. To specify a synonym filter or a stopword filter, click the corresponding arrows and 
select the required filters from the lists of available filters.
The Filters box shows all user defined filters stored in the default directory.
Note that character filters have .NRL extension, synonym filters have .SYN extension 
and stopword filters have .STW extension. 

7. Choose OK to validate group creation.
Search City saves the group definition and opens a different dialog box so you can add 
files to the new group.

To get help about how to create a text database, see:
Create a Text Database Group Definition



Create a Text Database Group Definition
The first step of the creation procedure is to establish a general group definition.

 To create a text database group definition
1.  From the File menu, choose New.

Search City opens the New Group dialog box.
2. Select    the Text Database Group option.

 In this case, the new group will have files divided into documents and fields.
3. Choose the OK button.

Search City displays the Create Text Database Group dialog box.
4. To define the group filename:

· Click any part of the File Name box and type the group filename.    Optionally,
you can specify a    path.
The filename can include a maximum of 8 alphanumeric characters, plus the file path, 
if specified.
Groups must have a .SCG extension. If not specified, Search City will add it for you.
If the Use Default Directory option from the Options menu is active, the new group will 
automatically be saved in C:\SEARCHIT. 
If this option is not active or if you want to save the new group in another directory, 
you must specify the complete path in the File Name box.

-Or-
Choose the Browse button to define the filename and its path using the 
Browse dialog box
Double-click in a lower level directory to open it or in a higher level directory to move 
up in the directory hierarchy. When the Directories: message indicates the required 
path, type a filename for the new group in the File Name box and choose the OK 
button to validate the dialog box information.

5. Type a sentence in the Description box so you    can easily identify the new 
group. 
This is optional information. Nevertheless, it is very handy if you create several groups 
with similar filenames. 
The description text can have up to 255 characters.

6. In the Filters box, select the Character Filter you want to apply to the group.
To do so, click the arrow and select any character filter from the    list of available 
character filters.
The    group must have a    character filter.

7. You can select a Synonym Filter and/or a Stopword Filter for the group.
The synonym and stopword filter boxes display None by default, since these are optional 
filters. To specify a synonym filter or a stopword filter, click the corresponding arrows and 
select the required filters from the lists of available filters.
The Filters box shows all user defined filters stored in the default directory.
Note that character filters have .NRL extension, synonym filters have .SYN extension 
and stopword filters have .STW extension. 

8. In the    Fields definition    area, click the Name box and type the name    of the    
first field    of the new    text database.
The field name can include any characters, including blank spaces.

9.  In the Recognizer box, type the character or character sequence used to 
indicate the beginning of the field in the file text.
Each    time Search City encounters the indicated character or character sequence, it 
places the text which follows it in this field.
You can specify more than one recognizer per field. The different alternatives must be 



separated by a plus sign (+) that represents a logical OR. For example, if you type #+%
+Name+Field1, Search City will introduce the text after any of these alternatives in the
indicated field:
- #
- %
- Name
- Field1
You can also use the special characters ^ and $ to specify the recognizer location. 
Insert a ^    to indicate beginning of line and $ to indicate end of line. For example, if 
you type ^author$ it means that the character sequence 'author' must be found at 
the beginning of a line and followed by a carriage return in order to be considered a 
field recognizer. 
You can also include an asterisk (*) wildcard in the recognizer character sequence to 
specify any zero or more characters. If you type author*, for example, Search City will
consider that 'author' and 'authors' are valid recognizers for that field.

10. Choose the Insert button to add the field to the database.
The field and its recognizers are displayed in the list of fields and the text boxes are 
cleared so you can enter other fields. 
Repeat steps 8 to 10 to add all required fields to the new database. 
Each time you insert a field, it is added at the end of the field list. If you want to add a 
field in any other position, click    on a field from the list of fields. Search City will insert
its name and recognizer in the text boxes. Modify this information and choose Insert. 
Search City will then add the new field preceding the field you selected from the list. 

The Delete button lets you suppress any field you have defined. Select a field from the list
and choose the Delete button. Search City deletes the field from the list but leaves the 
field name and recognizer in the text boxes. You can change the text and insert the 
modified field or just delete it with the keyboard.

11. In the Doc. Name box, select one of the fields as the document name for the 
text database documents.
Search City automatically selects the first field as the document name. To select any 
other field , click the arrow and select a a field name from the list of defined fields.

12. In the Doc. Recognizer box, type the character or character sequence 
indicating the beginning of the documents in the file text. 
This is an optional field, since Search City will consider the first field's recognizer as the 
beginning of the document if you don't provide special document recognizers.
Nevertheless, it is very useful if you want to add text at the beginning of a document 
before the first field or if you want to include several documents without fields stored in 
one file in your database.
As in the case of field recognizers, you can also use +, *, ^ and $ special characters.

13. Choose the OK button to create the database group.
Search City saves the group definition and opens a different dialog box so you can add 
files to the group.

To get help about how to create a file group, see:
Create a File Group Definition



Add Files to the New Group
When you validate a new group definition, Search City automatically opens the Group Files 
dialog box. In this dialog box, you can select all the files you want to add to the new group.
Search City can import files saved in ASCII file format into a text database, and it accepts 
ASCII, Word and WordPerfect file formats in a files group. Files can be stored in any hard disk 
directory as well as in external drives.

If the Use Default Directory option is selected, the dialog box opens with the default 
directory  selected. 

To add files to the new group
1. In the Current Drive box, select a drive.

Search City indicates drive C: by default. To select another drive, click the arrow and then 
click the drive letter.
Search City displays the directory tree corresponding to the selected drive.

2. In the directory tree, click a directory or subdirectory containing files you want 
to add to the group.
The selected directory is highlighted and all the files it contains are listed in the box on 
the right hand.

3. Choose the Mark button to open the Mark Files dialog box.
In the File Specification box, you can type the name of the file you want to add. Use DOS 
wildcards to add several files at once. For example, you can select all files with .DOC 
extension if you type *.DOC. By default, Search City displays *.*, which selects all files in 
the directory.
In addition, you can select the Search in Subdirectories option to select the files whose 
filenames are specified in the box, located in all the subdirectories dependent on the 
active directory.

4. Choose the OK button.
Search City closes the dialog box and the selected files are indicated with the pin icon.

5. You can complete    file selection as follows:
· Mark or unmark any individual file by double-clicking its name in the file list. 
· Choose the Unmark button to display the Unmark Files dialog box.

The Add option in the Mark for box is selected by default. With this option selected, 
you instruct Search City that you want to unmark files you previously marked for 
adding.
In the File Specification box you can indicate the name of the file you would like to 
unmark from the current directory.    Use DOS wildcards to specify several files at once. 
For example, you can indicate all files with .BAK extension if you type *.BAK. By 
default, Search City displays *.*, which unmarks all files in the directory.
In addition, you can select the Search in Subdirectories option to unmark the files 
whose filenames are specified in the box, located in all the subdirectories dependent 
on the active directory.

The Unmark button makes file selection much easier if you want to mark most files 
and/or file extensions from the active directory. For example, you can select all files 
using the Mark button (*.*) and then unmark those you don't want to add by means of 
the Unmark button.
It also lets you unmark files you marked by mistake.

· Choose the Hide button to access the Hidden Extensions dialog box.
This dialog box indicates all the file extensions hidden by the user. When you hide an 
extension, the files with that extension are not displayed in the file list.
The list of hidden extensions is valid for all groups. Search City saves it from one work 
session to another. 



Since the Mark button only selects the files displayed in the file list, you can hide the 
file extensions you do not require and then select files with the wildcard *.*.

To add a file extension to the list of hidden extensions, type its name, including the 
period (.) (for example, .PM4) and choose the Add button.
To exclude an extension from the list, in order to display the filenames with that 
extension, select the extension from the list and choose the Remove button.
To return to the Group Files dialog box, choose Close.

Once you have finished marking files in the current directory, select another directory 
from the directory tree and mark the files you wish to include in the group.
Each time you mark one or more files from a directory, Search City marks the directory 
with a check mark, so you can keep track of the directories containing files which will be 
added to the group.

6. Once you have marked all the files you want to add to the group, choose the OK
button. 
Then Search City displays the group with all the files you added in the main window. Now 
you must index the group.
If you added files to a database, the number of documents indicated by Search City 
might be bigger than the number of files added to the group, since one file may 
contain several documents.



Modify a Group
You can easily modify any group created in the past in order to suit your new requirements. 
Modifications can be made to:
· Group definition, that is, its description, the filters used for normalizing text, and if 

relevant, the database structure.
· The set of files that form the group:

You can add other files to the group using the same procedure involved in adding files to 
a newly created group. 
You can also remove files from the group. To do so, you must first mark the 
files/documents you want to delete and then actually delete them by packing the group.
Search City includes files marked for delete in your searches until you delete them with 
the Pack command.

· The text in your files/documents:
You can modify the contents of the group's files with the applications used to create them.
In the case of database groups, you can also use the Add Text command to include 
documents in one of the group's files.

Each time you modify one of these elements or properties, you must re-index the group 
before executing searches.
The Check command informs you about the group index status, specifying the changes you 
have introduced.
You must open the group you want to modify.

You can get help about any of the following procedures
Modify the Group Definition
Add Files to an Existing Group
Delete Files from the Group
Modify the Textual Contents of the Group Files
Manage the Group Index



Modify the Group Definition
The Properties command lets you modify group definition by means of a dialog box identical 
to the one you completed when creating the group. You can change any of the definition 
elements, except the group name and file path.

To modify group definition
1. From the File menu, choose Properties.

Search City displays the Group Properties dialog box.
2. Do one of the following:

· Modify the group description by typing a different text in the Description 
box.
Since this is optional information, the Description box may remain empty. 

· Modify the set of filter files attached to the group.
You can select any character filter, synonym filter or stopword filter available. To do so,
click the arrows on the corresponding boxes and select a filter from the filter lists.
Remember that you must specify a character filter, while synonym and stopword filters
are optional, so you can select the None option.

The Filters box displays all user defined filters located in the default directory.

3. And if you are working on a text database group, modify any of the following 
text database structure elements:
· Modify the field defined as the document name, choosing another field from 

the list of fields in the Doc. Name box. 
· Modify document recognizers in the corresponding box.

Remember that this is optional information which enables you to separate the 
beginning of the document from the beginning of the first field. If you specify a 
document recognizer, you can add documents without fields to the group as well as 
documents containing plain text before the first field's text. 
For example, you can add a new character or character sequence as a document 
recognizer, separated from the other alternatives by a plus sign (+). Search City will 
start a new document each time it encounters, in the text file, any of the document 
recognizers you have defined.

· Add or delete    any database field with the Add and Delete buttons, applying 
the same procedure used when you created the group.
Remember that the field name and at least one recognizer must be indicated.

If you delete a field that contained text in any of the group's documents and you don't 
specify a new function for the field's recognizers, the field's text will be displayed as 
part of the preceding field.

· Modify any field name or recognizer.
To do so, select the field you want to modify from the field list and choose the Delete 
button. Search City deletes the field definition, withdrawing the field from the list, and 
inserts the field name and recognizer in the text boxes so you can introduce 
modifications. Then, insert the modified field with the Add button.

4. Once you have introduced all required modifications, choose the OK button.
Search City returns to the main window and displays the group with all the changes 
specified. Remember you must index the group before executing searches.



Add Files to an Existing Group
You add files to an existing group by using the same procedure applied to add files to a new 
group.

To add files to an existing group
1. From the File menu, choose Group Files.

Search City displays the Group Files dialog box.
This dialog box indicates all of the group's files as well as their directory location. Thanks 
to the status icons, you can add files to the group without confusion, using the same 
procedure applied when you first added files to a new group.
Status icons:

· a blue check mark indicates that the directory contains one or more of the group's 
files
· a red check mark indicates that you have modified the group's files in this directory
· the file icon indicates that the file belongs to the group
· a pin indicates that the file has been marked to be added to the group

2. In the Current Drive box, select a disk drive.
Search City displays the selected drive's directory tree.

3. In the directory tree, click the directory or subdirectory containing files you 
want to add to the group.
The selected directory is highlighted and the directory's files are displayed in the file list.

4. Choose the Mark button to open the Mark Files dialog box and specify the file 
you want to add in the File Specification box.
The Mark Files dialog box has the Add option in the Mark for box selected by default, 
so you don't have to specify this option.

Remember you can use DOS wildcards to add several files at once. You can also select the
Search in Subdirectories option to select files in the subdirectories dependent on the 
active directory.

5. Choose the OK button.
Search City closes the dialog box and the selected files are indicated with the pin icon.
When you select a different subdirectory, Search City indicates with a red check mark 
that the previously selected directory contains files that will be added to the group.

6. You can complete    file selection as follows:
· Mark or unmark any individual file by double-clicking its name in the file list. 
· Choose the Unmark button to display the Unmark Files dialog box and 

specify the files marked for adding you want to unmark.
Remember you can use DOS wildcards in the File Specification box to add several files 
at once. You can also select the Search in Subdirectories option to select files in the 
subdirectories dependent on the active directory.

The Unmark Files dialog box    always opens with the Add option selected in the 
Unmark for box. When this option is selected, you can only unmark files you have 
previously marked for adding. If you try unmarking files    in a directory that does not 
contain any files marked for adding, the action will have no effect.

· Choose the Hide button to access the Hidden Extensions dialog box. 
Then you can specify the extensions that you don't want to display.
When you hide an extension, the files with that extension are not displayed in the file 
list, and thus are not selected with the Mark button.
To add a file extension to the list of hidden extensions, type its name, including the 
period (.) (for example, .INI) and choose the Add button.
To exclude an extension from the list, in order to display the filenames with that 
extension, select the extension from the list and choose the Remove button.



Follow the same procedure to mark all the files you want to add to the group.
7. Once you have selected all the files you want to add to the group, choose the 

OK button. 
Search City displays the group in the main window, including the files you just added. 
Now you must re-index the group before executing searches.
The total number of files is modified since it includes the files you just added to the 
group.
Remember you can actually mark files for adding and deleting at the same time.



Delete Files from the Group
When you delete files, you do it in two steps. First, you mark the files you want to delete and
then you actually delete them by packing the group.
Search City includes files marked for delete in your searches until you delete them with the 
Pack command.
To mark the files you want to delete you can use the Group Files dialog box. You can also 
mark files for deletion in the main window, by using the status bar or the Mark File for Delete
command from the Edit menu.

In the case of a text database, one file may contain    several documents. If you mark a
file for deleting in the Group Files dialog box, you will delete all the documents it 
contains. So if you only wish to delete some of the documents    stored in a file, you 
should mark them individually in the main window.

The deleting procedure excludes files from the group's file composition but doesn't actually 
delete them from the hard disk or floppy disk where they are stored. If necessary, you can 
add a deleted file to the group again.
For further information see:
Mark Files for Deletion in the Group Files Dialog Box
Mark Files for Deletion in the Main Window
Pack a Group



Mark Files for Deletion in the Group Files Dialog Box
1. From the File menu, choose Group Files.

Search City displays the Group Files dialog box.
This dialog box indicates all of the files in the group as well as their directory location. 
Thanks to the status icons, you can easily mark the files you want to delete.
Status icons:

· a blue check mark indicates that the directory contains one or more of the group's 
files
· a red check mark indicated that you have modified the group's files in this directory
· the file icon indicates that the file belongs to the group
· the file icon with a cross indicates that the file has been marked for deletion

2. In the Current Drive box, select a disk drive.
Search City displays the selected drive's directory tree.
The a check mark on the directory icon identifies the directories that contain one or more 
of the group's files.
You can only delete files that belong to the group, marked with the file icon.

3. In the directory tree, click the directory or subdirectory containing files you 
want to delete from the group.
The selected directory is highlighted and the directory's files are displayed in the file list.

4. Choose the Mark button to open the Mark Files dialog box.
5. Select the Delete option in the Mark for box.
6. In the File Specification box, type the name of the file you want to delete. 

Use DOS wildcards to mark several files at once and select the Search in Subdirectories 
option to mark the files whose filenames are specified in the box, located in all the 
subdirectories dependent on the active directory.

7. Choose the OK button.
Search City closes the dialog box and marks with the delete icon all specified files.

8. You can complete marking files for delete    as follows:
· Mark or unmark any individual file by double-clicking its name in the file list. 
· Choose the Unmark button to display the Unmark Files dialog box and 

specify the files you want to unmark.
Select the Delete option in the Mark for box.
Use DOS wildcards to specify several files at once and select the Search in 
Subdirectories option to unmark the files whose filenames are specified in the box, 
located in all the subdirectories depending on the active directory.

When the Delete option in the Unmark box is selected, Search City only withdraws    
marks for deleting files. If you try unmarking files in a directory that does not contain 
any files marked for deleting, the action won't have any effect.

· Choose the Hide button to access the Hidden Extensions dialog box and 
specify the extensions you don't want to display.
When you hide an extension, the files with that extension are not displayed in the file 
list. Thus, you don't mark them with the Mark Files dialog box.
To add a file extension to the list of hidden extensions, type its name, including the 
period (.) (for example, .INI) and choose the Add button.
To exclude an extension from the list, select the extension from the list and choose the 
Remove button.

Once you have finished marking files in the current directory, select another directory 
from the directory tree and mark the files you wish to include in the group.
Each time you mark for delete one or more files from a directory, Search City marks the 
directory with a check mark, so you can keep track of the directories where you have 
introduced any modification.



9. When you have finished adding deleting marks, choose the OK button. 
Search City displays the main window. On the status bar, you can check all 
files/documents you have marked for delete. 
Now, you must pack the group in order to really delete the marked files.



Mark Files for Deletion in the Main Window
¨ In the status bar, click the file icon of the file you want to delete.

The file/document displayed in the text area is marked for delete and now the status bar 
displays the file icon with a cross.
If you click the status bar icon again, the delete mark disappears and the file/document 
returns to normal status.

-Or-
From the Edit menu, choose Mark File for Delete.
The file displayed in the text area is marked for delete and now the status bar displays 
the file icon with a cross.
When the text area displays a file marked for delete, the Edit menu includes the Unmark 
File for Delete command, which clears the deleting mark, leaving the file in normal status.
If you are working on a text database, commands are called Mark Doc. for Delete and 
Unmark Doc. for Delete.
Now you must pack the group to actually delete the marked files from the group.



Pack a Group
¨ From the Utilities menu, choose Pack.

Search City executes the packing procedure. All files/documents marked for delete will be 
deleted from the group.
Then you must update the group index to include all group modifications.



Modify the Textual Contents of the Group Files
There are two different ways to modify the group file texts:
· Modifying the files with the applications used to create them. In the case of a text 

database, files must be saved in ASCII format for Search City to read them. In the case of 
a file group, ASCII, Word and WordPerfect formats are accepted. Each time you modify a 
group file using another application, Search City acknowledges the changes and asks you 
to re-index the group. 

· Add Documents to a Text Database using the Add Text command. A dialog box is provided
so you can introduce text as documents divided into fields. Search City indicates which 
fields have been defined in the group database structure. Nevertheless, as with any 
document, it is not necessary to introduce text in all the fields. You can also add 
documents without any fields at all. New documents are added at the end of the group 
and they are stored in the file containing the last database document. If you add 
documents to a database, you must re-index the group.
The Add Text command is only available when you are working on a text database.



Add Documents to a Text Database
1. From the Edit menu, choose Add Text.

Search City displays the Add Text dialog box.
This dialog box indicates all the fields defined in the group database structure and 
provides a space after each field name so you can enter text.
Field names are unerasable.

2. Click on the blank line corresponding to the field where you want to enter text 
and type a text.
Text can have a variable length and may contain as many carriage returns as necessary.
Since the database structure is provided by Search City, it is not necessary to include 
field or document recognizers.
Use the scroll bar to move throughout the text if it exceeds the space provided by the 
box.
Repeat this operation to introduce text in all the fields you require.

3. Choose the Add button to add the document displayed in the box to the text 
database.
A message in the lower part of the box informs that one document has been added to the
text database.
The Add button is dimmed and unavailable until:
· You choose the Clear button to delete the text displayed in the box so you can enter a 

new document.
· You edit the field text in order to take advantage of it for the next document.
Once you add a document, you cannot modify its contents. In consequence, you 
should carefully review the text of the new document to confirm there are no mistakes
before choosing the Add button.

Repeat steps 2 and 3 until you have added all the documents you require to the group.
4. Choose the Close button.

Search City closes the dialog box and the main screen displays the group with all the 
documents you have added.
Now you must update the index to include these modifications.



Manage the Group Index
To execute searches, you must create an index for the group you want to work with and 
update it each time you make any modifications to the group.
The Check command informs you about the group index status by means of the Check 
Group dialog box.
In addition, this dialog box lets you know if any of the group's files have been modified using
another application, or if they are missing. Search City reports as missing any file that is no 
longer in the file path specified when you added it to the group. In other words, if you delete 
a file or change its directory location from the operating system, Search City considers it is 
missing. All missing files are listed. You can eliminate these files from the group's file 
composition or reinstall them in their appropriate directories. You must update the 
composition of the group to effectively update the group index. As for modified files, the 
changes are automatically introduced when you re-index the group.
To index the group for the first time and to update the group index, you choose the Index 
command.
Indexing is done progressively. When you choose the Index command, Search City only 
indexes the part of the group that needs updating. This feature offers the following 
advantages:
· it simplifies the indexing of large amounts of information, since you can interrupt the 

process at any time and take up indexing later,
· it reduces indexing time considerably when you add new documents or files to the group, 

since Search City only completes the index instead of indexing the whole group again.
The Full Index option from the Options menu, enables you to execute complete indexing 
instead of progressive indexing. 

You can get information about any of the following procedures:
Examine Index Status and Group File Composition
Index a Group



Examine Index Status and Group File Composition
To examine index status
1. From the Utilities menu, choose Check.

Search City displays the Check Group dialog box.
The main message in this box tells you whether the index is updated or not. Any group 
modification since the last time you indexed the group will be stated. In addition, this 
dialog box informs if there are any modified or missing files.

To restore missing files 
¨ Copy the missing files into the appropriate directories again.

Search City will recognize them, so you won't have to re-index the group again.

To remove missing files from the group
1. From the Utilities menu, choose Check.

Search City displays the Check Group dialog box, indicating the missing files.
2. Choose the Delete button.

The Missing File List is cleared and Search City removes these files from the group's file 
composition.



Index a Group
1. Select the Full Index option from the Options menu if you want Search City to 

perform a complete index.
When this option is active, a check mark is displayed next to the option in the menu.
On the contrary, if you want Search City to perform progressive indexing, make sure this 
option is not selected.

2. From the File menu, choose Index.
Search City displays a message box indicating the indexing progress.
The Abort button lets you interrupt the indexing procedure. If you choose this button, 
Search City stops indexing. If the Full Index option is selected, you will have to start 
indexing all over again. On the contrary, if this option is not selected, Search City stores 
the part of the index already completed so you can take indexing up at the point where it 
was interrupted the next time you choose the Index command.
When indexing is completed, a dialog box is displayed.

3. Choose the OK button.
Search City displays the main window. If you choose the Check command, you can verify 
that the index has been updated.



Work with Filters
In Search City, you can use filters to define transformation rules applied to your texts. In 
other words, you can specify a set of rules used to normalize group files and query text, thus
increasing your text retrieval capabilities.
Search City works with the following filters:
· character filter
· synonym filter
· s  t  opword filter  
In the character filter, you define character usage. This is the only obligatory filter, and 
Search City provides a standard version it applies by default to every group you create -
unless you define other character filters.
The synonym filter is an optional filter used to define equivalent words. It consists of a list of 
words with their synonyms. Specified synonyms may be character sequences, words or 
phrases. You can create as many synonym filters as required and, additionally, include one 
filter within another. Thanks to this feature, you can tailor your filters according to each 
group's contents.
The stopword filter is also optional and is similar to the synonym filter. In this case, it 
consists of a list of character sequences, words or phrases that do not have any relevance in
the textual context of your searches. The irrelevant words -or stopwords- will be ignored by 
Search City when executing queries.
Filters are stored in the default directory. You can apply them to any existing group.
Since filtering is performed during indexing, you must index a group after modifying its 
filters.

You can get information about the following subjects:
Create a Character Filter
Modify a Character Filter
Create Synonym and Stopword Filters
Modify Synonym and Stopword Filters
Synonym and Stopword Filter Syntax
Delete Filters



Create a Character Filter
When you create a character filter, Search City provides the standard version character 
definition (DEFAULT.NRL) as the basis of the new filter. Thus, you can avoid basic mapping.
You can also create a character filter starting from a filter different from the standard one. In 
that case, you edit the model filter and then save the new version with another name.

To create a character filter
1. In the Utilities menu, choose Filters.

Search City displays the Filters dialog box.
In this box, you can indicate the type of filter you want to create; in this case, a character 
filter. The Filter Filenames box provides the list of existing filters that correspond to the 
selected filter type option.

2. Type a filter name.
Character filters have the extension .NRL. If not specified, Search City includes it for you.

3. Choose the Edit button.
Search City opens a dialog box to confirm you want to create a new filter. 

4. Choose Yes to create a filter with the specified name.
If you choose the No button, the Filters dialog box appears again so you can modify the 
filter name. 
Search City displays the New Character Filter dialog box.
The Filter box shows the new filter's filename. Search City provides the file path, as it 
corresponds to the default directory.
This dialog box presents the standard filter configuration. If you click any character on the
map, the Character, Map and Type boxes provide information about the selected 
character definition. 
The Character and Map boxes indicate character equivalence -expressed as a character 
and its character set code- whereas the Type box indicates the type of character.
All highlighted characters have been defined as part of word or word-joining characters.    

5. In the Description box, type a sentence to identify the new filter.
6. If necessary, select the Case Sensitive option.

When this option is active, capital and small letters are considered different characters. 
For example, if you search for "house", Search City will not select the instances of 
"House" it encounters in the group's texts. 
If you click any capital letter from the character map with the Case Sensitive option 
selected, you can verify that it has not been defined as equivalent to its corresponding
lower-case letter. On the contrary, if this option is not selected, the character map 
indicates that all capital letters will be considered as lower-case letters when you 
perform searches. 

7. Click a character on the character map to modify its definition.
The Character, Map and Type boxes provide information about the selected character.

8. Do one of the following:
· Modify the character equivalence specified in the Map box.

To do so, type a new character or its character set code. Search City automatically 
completes the box with the other value. 

· Modify the type of character definition.
Click the arrow from the Type box and select another option.
Characters can be considered as part of word or word-joining characters. In both cases,
they are highlighted in the character map. If you choose the None option in the Type 
box, the character will be considered as a word separator and won't be taken into 
account.

9. Choose the Accept button to validate character definition modifications.
If you select another character from the character map before choosing the Accept 



button, Search City does not save modifications.
Repeat steps 7 to 9 to modify all required character definitions.
If you choose the Set Default button, Search City presents the standard filter 
configuration again. This button lets you start all over again in case you are not satisfied 
with modifications you have introduced.
At any point of the creation procedure you can use the Save As button to save the current
state of the character filter as a different filter. In that case, Search City displays the Save 
As dialog box so you can introduce a different filter file name.

10. Choose the OK button.
Search City returns to the main window. If you choose the Filters command again, the 
filter you just created will appear in the list of available character filters.



Modify a Character Filter
With Search City, you can modify any character filter available, including the DEFAULT.NRL 
standard character filter, provided with the application. 

To modify a character filter
1. In the Utilities menu, choose Filters.

Search City opens the Filters dialog box, with the character filter option selected.
Filters are sorted in alphabetical order. If the list is longer than the space provided by the 
box, a scroll bar will appear.

2. In the Filter Filenames box, select a filter from the list.
3. Choose the Edit button.

Search City asks if you really want to modify the specified filter.
4. Choose the OK button.

The Modify Character Filter dialog box appears.
The Filter box displays the filter's filename and path.
This dialog box presents the selected filter's configuration. If you click any character on 
the map, the Character, Map and Type boxes provide information about the selected 
character definition. 
The Character and Map boxes indicate character equivalence -expressed as a character 
and its character set code- whereas the Type box indicates the type of character.
All highlighted characters have been defined as part of word or word-joining characters.    

5. Do one of the following:
· In the Description box, type a new sentence to identify the filter.
· Select or clear the Case Sensitive option.

When this option is active, capital and lower-case letters are considered different 
characters. 

6. Modify character definition.
In the first place, select a character from the character map.
You can modify the character equivalence specified in the Map box. To do so, type a new 
character or its character set code. Search City automatically completes the box with the 
other corresponding value. 
You can also modify the type of character definition. Click the arrow from the Type box 
and select another option. Finally, choose the Accept button to validate the new character
definition.
Repeat this operation as many times as necessary until the character map configuration 
suits your needs.
If you choose the Set Default button, Search City presents the standard filter 
configuration. This button lets you start all over again in case you are not satisfied with 
character definition.

7. Do one of the following:
· To save the filter with the modifications you have introduced, choose the OK 

button.
-Or-

To create a different filter with current configuration, choose the Save As 
button.
Search City displays the Save As dialog box.
Type a new name for the filter and choose the OK button. Then choose the OK button 
from the Modify Character Filter dialog box.
The new filter is added to the list of available filters whereas the filter you originally 
selected for modifying has not been changed.



Create Synonym and Stopword Filters
Synonym and stopword filters are optional in group definition, but they are extremely useful 
for expanding your search power. 
You can create as many synonym and stopword filters as you need. In addition, with Search 
City you can include one filter inside another -- synonym filters inside other synonym filters, 
and stopword filters inside stopword filters. If you create different "basic" filters, you can 
combine them to build up very specific synonym and stopword filters for each group.
Each time you create a synonym or stopword filter, you start from a blank file. If you want to
use a previously created filter as a model, you can edit it and save the new version as a 
different filter file with the Save As command.

To create a synonym or stopword filter
1. In the Utilities menu, choose Filters.

Search City displays the Filters dialog box.
2. In the filter Type box, select the type of filter option desired. 

The Filter Filenames box provides the list of existing filters that correspond to the selected
filter type option.

3. Type a filter name.
Synonym filters have .SYN extension and stopword filters have .STW extension. If not 
specified, Search City includes the extension for you.

4. Choose the Edit button.
Search City opens a dialog box.

5. Choose Yes to create a filter with the specified name.
If you choose the No button, the Filters dialog box appears again so you can modify the 
filter name. 
Search City uses Windows Notepad environment to edit synonym and stopword filters. 
Notepad opens automatically and displays a dialog box to confirm you want to create a 
new file.

6. Choose Yes.
Notepad creates a new file with the specified filter filename.

7. Type the filter contents.
The filter file text must respect the Synonym and Stopword Filter Syntax.

8. From the File menu, choose Save.
9. From the File menu, choose Exit.

Search City returns to the main window. If you choose the Filters command again, the 
filter you just created will appear in the list of available filters.



Modify Synonym and Stopword Filters
To modify a synonym or stopword filter
1. In the Utilities menu, choose Filters.

Search City displays the Filters dialog box.
2. In the filter Type box, select the type of filter option desired. 

Search City displays the list of available filters corresponding to the selected filter type 
option. Filters are sorted in alphabetical order. If the list is longer than the space provided 
by the box, a scroll bar will appear.

3. In the Filter Filenames box, select a filter from the list.
4. Choose the Edit button.

Search City displays a dialog box.
5. Choose the OK button.

Search City uses Windows Notepad environment to edit synonym and stopword filters. 
Notepad automatically displays the filter you are going to edit.

6. Modify the filter contents.
The filter file text must respect the Synonym and Stopword Filter Syntax.

7. Do one of the following:
· To save the filter with the modifications you have introduced, choose Save 

from the File menu.
-Or-

To create a different filter with current configuration, choose Save As from 
the File menu.
Notepad displays the Save As dialog box, so you can type a new name for the filter in 
the File Name box. Then choose the OK button.

Don't modify the filter file path, since Search City only recognizes filters    stored in the 
default directory.

The new filter is added to the list of available filters whereas the filter you originally 
selected for modifying has not been changed.

8. From the File menu, choose Exit.
Search City returns to the main window.



Synonym and Stopword Filter Syntax
The synonym and stopword filter syntax is similar and very simple. 
· At the beginning of the filter file, type the character sequence !Description followed by a 

sentence --delimited by quotation marks-- describing the contents of the filter file.
· The list of entries must be as follows:

Each entry is a transformation rule applied to the text involved in your searches. Search 
City takes all instances of the expression you type to the right of the equal sign and turns 
them into the expression to the left of the equal sign. An expression can be a character 
string, a word or a phrase. In the case of a phrase, you must type it delimited by 
quotation marks. When you specify more than one expression per entry, a blank space is 
enough to separate them. 
You may include as many entries as desired in one filter. They may be sorted in any order:
alphabetical or lexicographic, by meaning, etc. 
In the case of a synonym filter, each entry consists of a character sequence, word or 
phrase, an equal sign and afterwards, as many character sequences, words or phrases 
you want to specify as synonyms.
In the case a of stopword filter, each entry consists of a pair of quotation marks, an equal 
sign and afterwards, one or more character sequences, words or phrases which you want 
to ignore in your search texts. 

· You can include a backslash (\) in expressions as an escape character for quotation marks
and the backslash itself. In other words, if a stopword or synonym character string 
includes quotation marks or a backslash, you must type a backslash before these 
characters in order to inform Search City that they are simple characters in the 
expression.

· Type a semicolon (;) to introduce comments in any part of the filter file. Search City will 
consider as comments all text to the right of the semicolon until the next carriage return.

· In any new line, type the character sequence !include, followed by a filename -- with 
extension -- and a carriage return, to include the specified filter file in the current filter. 
Filenames must correspond to valid synonym or stopword filters. You can type as many !
include lines as necessary.



Delete Filters
In Search City, you can delete any character, synonym or stopword filter available. 
Nevertheless, once you delete a filter file, you cannot apply the filter to any group. 
When you delete a filter that formed part of a group definition, the group no longer has a 
filter of the deleted filter type. Since groups must have a character filter, you will have to 
choose a different character filter for the group the next time you want to work with it.

To delete a filter
1. In the Utilities menu, choose Filters.

Search City displays the Filters dialog box.
2. In the filter Type box, select the type of filter option desired. 

The Filter Filenames box provides the list of existing filters that correspond to the selected
filter type option.

3. Select a filter name.
4. Choose the Delete button.

Search City asks for confirmation to delete the selected filter.
5. Choose the OK button.

Search City returns to the Filters dialog box. You can delete other filters repeating steps 2 
to 5. 

6. When you have finished deleting filters, choose the Close button.



Execute a Query
Before executing queries you must open a group. In other words, you must specify the set of
files you want to work with. Furthermore, you have to index the group and the index must be
updated. Otherwise, Search City cannot perform its text retrieval tasks efficiently. 
When you search for a given expression in the group's texts, you perform a query. Queries 
can be as simple or as complex as you need, including operators and special symbols to 
meet your different requirements.
The query expression must respect query language syntax. To execute a query, you type a 
text in the query edit area. You can also use the Subjects tool and work with previous queries
to make your searches more efficient.

To execute a query
1. Activate the query bar by clicking the query edit area. 

Search City displays an insertion point so you can enter text.
2. Type the text of the query you want to execute. 

To write a query, you can delete or edit the previous query text displayed in the edit area.
If the query is longer than the space provided by the query edit area, it will expand to 
provide the necessary space. 
Search City displays a pencil icon on the query bar to show that the query edit area 
contains text that does not correspond to an executed query. 

3. Press the ENTER key. 
Search City displays the Searching dialog box. You can interrupt the search by choosing 
the Abort button.
When the search operation is over, the dialog box automatically closes and Search City 
presents the results of the query.

To get help about how to examine query results, see:
Work with the Query Results



Work with the Query Results
When you execute a query successfully, Search City returns a set of hits encountered in the 
active group. Hits correspond to all the instances of the queried expression found in the 
group's texts. Search City assigns a correlative number to each hit so you can identify it in 
relation to the set of hits returned. It also provides the total number of hits. 
Hits can be located in one or more of the group files. In consequence, each query "selects" a
set of files from the group. To simplify your work, Search City indicates the total number of 
selected files and it assigns a correlative number to each one of them. 

When working on a text database, Search City selects a set of documents.

As you can see, working with query results involves managing the set of hits as well as the 
set of files returned by a query. Search City provides all the information related to these 
results on the main screen.

If the query does not produce any hits, the text area becomes blank and screen 
messages indicate that no hits nor files were returned by the previous query.    

For further information, see the following procedures:
Review Query Results Through the Hit List
Display the Hit List Automatically After Each Query
Examine Hits One by One in Their Textual Context
Review Query Results Through the File List
Examine Files One by One in the Main Window



Review Query Results Through the Hit List
1. From the View menu, choose Hits.
-Or- 

Choose the Hits button.
Search City displays the Hit List. This dialog box displays a complete list of the 
expressions that match your last query, providing useful information about the query 
results: total number of hits, file location, complete file path and textual context of each 
hit.
This dialog box appears automatically after each query if you have selected the Auto 
Show Hits option. 

2. Select a hit by clicking it on the list of hits. 
The dialog box's messages change to provide information about the selected hit. 

3. Choose the OK button. 
Search City closes the dialog box and displays the selected hit in the text area.



Display the Hit List Automatically After Each Query
¨ From the Options menu, select the Auto Show Hits option. 

When you select this option, a check mark appears on the left side of the option on the 
menu. To deactivate the Auto Show Hits option, choose the option again and the check 
mark will disappear. 



Examine Hits One by One in Their Textual Context
¨ From the View menu, choose Next Hit. 
-Or- 

Choose the Next Hit navigation button. 
Search City selects the next hit from the list of hits and displays it as the current hit in the
text area. 
The Previous Hit navigation button and the command with the same name from the View 
menu let you select the previous hit from the hit list and display it as the current hit in the
text area. 
When you move from one hit to another, the correlative number displayed varies 
according to the selected hit. In addition, the file correlative number may also change 
if you select a hit located in a different file. 



Review Query Results Through the File List
¨ From the View menu, choose Files. 
-Or- 

Choose the Files button.
Search City displays the File List. This dialog box displays a list of all files containing 
expressions that match your last query    and provides useful information about them: 
number of hits per file and complete file path. 

2. Select a file by clicking it on the list. 
The dialog box's messages change to provide information about the selected file. 

3. Choose the OK button. 
Search City closes the dialog box and displays the selected file in the text area. 
The text area displays the first hit found in the current file. 



Examine Files One by One in the Main Window
¨ From the View menu, choose Next File.
-Or- 

Choose the Next File navigation button.    
Search City selects the next file from the file list and displays it in the text area. 
The Previous File navigation button and the command with the same name from the View 
menu let you select the previous file from the file list to display it in the text area. 
When you move from one file to another, Search City always displays the first hit from 
the selected file. The correlative hit number displayed changes according to the 
current hit. 



Work with Previous Queries
In Search City, you can take advantage of the queries you have previously executed, since 
they are stored in the History list. This is a list of the last 99 queries performed with the 
application, accumulated throughout your different work sessions. Search City assigns a 
correlative number to every query you execute, adding it to the end of the historical query 
list. Therefore, this list is an accurate "diary" of your text retrieval work. 
Beyond its orientation function, and equally important, the History list lets you performs the 
following tasks:
· Re-execute a previous query.
· Edit a previous query and then execute it.
The query bar gives you instant access to the History list. You can also display the list by 
choosing the Queries button or the command with the same name from the View menu.

For further information, see:
Use the History List in the Query Bar
Use Previous Queries by Displaying the History List



Use the History List in the Query Bar
The query bar provides the following elements:
· On the left hand, the box contains a number. This number identifies the query displayed 

by Search City in the query edit area. You can modify this query number by clicking the 
arrows or typing a different value; the query displayed varies accordingly.

· The arrows let you increase or decrease the number displayed in the box. Search City 
displays the query identified by the number in the edit area. Thus, they move you 
through the History list.

· The continuous arrow indicates that the results displayed in the text area correspond to 
the query specified in the query bar (number and text). If Search City shows a 
discontinuous arrow, it means that result and query do not match, since the query 
indicated in the query bar corresponds to a historic query. If Search City displays a pencil 
icon instead, it means the text in the query edit area is recently typed text, which has not 
been executed as a query.

· The query edit area -- where you type a query you are going to execute -- is also used to 
display the query text of the historical queries. You call a historical query by specifying its 
query number.

To use previous queries with the query bar
1. Click the arrows on the query bar to increase or decrease the query number in 

order to call the required query.
The insertion point appears in the edit area.

-Or-
Type the query number in the box.
Click the number box, delete the existing number and type the required value. To display 
the query text associated to the number, press ENTER.
The query number must be a whole number under 99. If the History list does not have 
99 entries, the value cannot exceed the last query's number.

2. Then do one of the following:
· To execute the query, press ENTER.
-Or-

To edit the query, use the keyboard and the Cut, Copy and Paste commands 
on the Edit menu. Then you can execute it like any other query, pressing 
ENTER on your keyboard.
In both cases, Search City displays the Searching dialog box while executing the task. 
Then you see the query results in the main window. Observe that the executed query 
is added at the end of the History list with a new query number, whether or not you 
edited it before executing it.



Use Previous Queries by Displaying the History List
1. Choose the Queries button in the toolbar.
-Or-

From the View menu, choose Queries.
Search City opens the History dialog box.
This dialog box displays 99 historical queries. When you open the dialog box, the last 
query you executed is selected.

2. On the list, click the query you want to use again.
If necessary, utilize the scroll bar to display the required query in the list box.
The Detail box displays the selected query text, which might exceed the space provided 
in the list box. It also indicates if the query was executed with a subject as a selector, that
is, a limited search universe within the group.

3. Do one of the following:
· Choose the Search button to re-execute the selected query again.

The dialog box closes and Search City executes the query. Then the text area displays 
the query results.

-Or- 
Choose the Edit button to modify the selected query before re-executing it.
Search City inserts the selected query in the query edit area and displays the insertion 
point. Now you can introduce any required modification.
Use the keyboard and the Cut, Copy and Paste commands on the Edit menu to change 
query text. Then you can execute it as any query, pressing ENTER on your keyboard.

In both cases, Search City displays the Searching dialog box while executing the task. 
Then you see the query results in the main window. Observe that the History list includes 
the executed query with a new query number, whether you edited it before executing it 
or not.



Use the Subject Tool
As you work on your texts, the History list changes to include your new searches. Subjects 
give you a quick and easy way to store queries permanently, leaving them at hand. 
Over time, you will probably notice that there are queries you execute frequently. By saving 
them as subjects, you can save time and execute them as many times as necessary.
On the other hand, subjects help you classify information contained in texts. By using them, 
you can focus your searches progressively. With query language operators and types of 
searches, you can express varied information retrieval criteria. For example, distance 
searches allow you to select information by proximity, the and operator by inclusion, etc. You
can create many sets of subjects to meet your different needs. Then you can apply them as 
selectors, limiting the search universe within the group. 
When you choose the Subjects button or the Subjects command from the View menu, the 
Subjects dialog box opens. This box displays all user defined subjects and provides a set of 
tools so you can really take advantage of the subjects you create.

Each group has its own Subject list. You cannot use subjects from one group for 
another.

You can get information about the following procedures:
Create a Subject
Execute a Subject
Edit a Subject
Use Subjects to Limit the Search Universe
Rename a Subject
Delete a Subject



Create a Subject
To save a query as a subject, you must execute it and leave it displayed in the query bar.

To create a subject
1. Choose the Create Subject button on the toolbar.

Search City displays the Create Subject dialog box.
2. Type a subject name for the current query in the Name box.

Subject names can have alphanumeric characters and blank spaces.
3. Choose the OK button.

You have created a subject, and thus included it in the subject list. You can look it up with 
the Subjects button.



Execute a Subject
Once you have created a subject, you can execute it as many times as you need.

To execute a subject
1. Choose the Subjects button on the toolbar.

Search City opens the Subjects dialog box that contains the subject list.
To display the list of subjects you must open a group. Otherwise, the Subjects button is
not available.

2. Select a subject by clicking its name on the list.
If the list box does not display the subject you are looking for, use the scroll bar until you 
find it.
The Detail box displays the query saved as the selected subject. You can make sure you 
have selected the right subject by checking its contents in this box.

3. Choose the Search button.
The dialog box closes and Search City executes the query. 
Once the search operation is over, the query bar displays the contents of the subject and 
the results appear in the text area.



Edit a Subject
On occasion, you may want to modify a subject before executing it. With Search City you can
do this easily and without effort.

To edit a subject and execute it
1. Choose the Subjects button on the toolbar.

Search City opens the Subjects dialog box that contains the subject list.
To display the list of subjects you must open a group. Otherwise, the Subjects button is
not available.

2. Select a subject by clicking its name on the list.
The Detail box displays the query text saved in the selected subject.

3. Choose the Edit button.
The dialog box closes and the subject's contents appear in the query bar.

4. Modify the query text.
You can use the keyboard and the Copy, Paste and Cut commands from the Edit menu.

5. Execute the query by pressing the ENTER key.
Search City performs the search operation and displays the query results in the text area.
If you wish, you can save the modified subject as a new subject by choosing the Create 
Subject button.



Use Subjects to Limit the Search Universe
In Search City, you can use subjects to restrict the set of files affected by a query. This is 
called using a subject as a selector. It means that when you execute a query, Search City 
only looks for the queried expression in the files selected by the selector -or subject. 
For example, let's suppose a secretary is working on the group MEMO.SCG, where she has 
gathered all the company's memos. The subject Management selects all files containing 
words such as 'director', 'executive officer', 'manager', 'supervisor' and other related words, 
as well as the names and last names of the company's board of directors. To retrieve 
information concerning management staff's summer vacation arrangements, she can look 
for instances of 'vacations', 'July', 'August' and 'summer', using the subject Management as a
selector.
To specify a selector, you can use the Selector box on the toolbar. This box provides the list 
of existing subjects so you can choose any one of them as the selector of your next query. 
When the None option is displayed in the Selector box, no selector is being used. Once you 
specify a selector, it remains active until you choose the None option again. 

To execute a query with a selector
1. Click the arrow on the Selector box to open the list of subjects. 
2. Click a subject name.

If the required subject is not visible, use the scroll bar until it appears in the box.
The drop-down list closes and the selected subject appears as the selector in the box.

3. Type a query in the query edit area.
You can also use the query text displayed in the edit area. This text may correspond to 
the last query you executed or to any historical query.
Remember you can also execute a subject from the subject list. In this case, you use a
subject (selector) to limit the search universe of the subject (query) you want to 
execute. To do so, you must first choose the subject you want to execute and specify 
you are going to edit it (Edit button on the Subject box). Then you define a selector 
and execute the query.

4. Choose the ENTER key.
Search City will look for the queried expression in the files specified by the selector; in 
other words, the query will only be applied to the set of files returned when you execute 
the subject.
If you open the History dialog box with the Queries button, you can see that the last 
query was executed using a selector.
The selector will be applied to all your succeeding queries until you modify it.

To modify or remove a selector
1. Click the arrow on the Selector box to open the list of subjects. 
2. Select a different subject as a selector.
-Or-

Select the None option on the list, to execute queries without a selector.



Rename a Subject
In the Subjects dialog box, you can rename any existing subject.
1. Choose the Subjects button on the toolbar.

Search City opens the Subjects dialog box.
2. Select a subject from the list.

Use the scroll bar to scroll through the subject list until you find the subject you are 
looking for.

3. Choose the Rename button.
Search City displays the Rename Subject dialog box.

4. Type a new subject name.
5. Choose the OK button.

Search City closes the Rename Subject dialog box and the subject list displays the new 
subject's name.
You can modify any subject name repeating steps 2 to 5.

6. Choose the Close button on the Subjects dialog box.



Delete a Subject
Over time, certain subjects may not suit your needs any more. To avoid accumulating 
unused subjects on the subject list, Search City lets you delete any subject you want.

To delete a subject
1. Choose the Subjects button on the toolbar.

Search City opens the Subjects dialog box.
2. Select a subject from the list.

Use the scroll bar to scroll through the subject list until you find the subject you are 
looking for.
The Detail box displays the selected subject's contents. Make sure you have selected the 
subject you need to delete.

3. Choose the Delete button.
Search City displays a dialog box asking for confirmation.

4. Choose the Yes button.
Then Search City deletes the selected subject from the list.
You can repeat steps 2 to 4 to delete any subject.

5. Choose the Close button on the Subjects dialog box.



Modify the Look of Text on your Screen
You can change the way texts appear in the main window by:
· Using the Wrap option to adjust the width of text to the space provided in the main 

window. This option is very useful if the text paragraph format is wider than Search City's 
text area.

· Using the Fonts command to define the font, font style and size.    By default, Arial 10 pts 
is used.

· Selecting the DOS Text option, to indicate that you wish to change the set of characters 
used to display texts in the text area: from DOS characters (OEM standard) to Windows 
characters (ANSI standard).

To adjust the text between the right and left margins
¨ From the Options menu, choose Wrap.

When this option is selected you can see a check mark on the menu item. 
To deactivate this option, simply select it again and the check mark will disappear.

To modify font and character style
1. Choose Fonts from the Options menu.

Search City displays the Font dialog box.
2. Choose the font, font style and size required.

The Sample box displays the look of text.
3. Choose the OK button.

Search City returns to the main window. The text area displays the active group's texts 
with the new font and style defined. The character format will apply to all open groups 
until you modify it again.

To transform the text character set from DOS standard to Windows standard
¨ From the Options menu, select the DOS Text option.

Search City transforms the display of the text from the OEM character set to the ANSI 
character set. This option remains active until you select it again.



Query Language
Search City's Query Language Capabilities
Word Search
Reserved Words
Phrase Search
Upper and Lowercase Characters, Spaces and Punctuation Marks
Word Search with Synonym and Stopword Filters
Searches with Special Symbols
Prefix Search
Wildcard Search
Range Search
Basic Query Language Operators
And Operator
Or Operator
Not Operator
Ex Operator
Inc Operator
Distance Searches
Modify the Distance Value
Near Operator
Before and After Operators
Using the Not Operator in Distance Searches
Nesting Distance Operators
Combining Operators and Other Query Language Elements
Operator Precedence
Parentheses
Examples of Query Combinations



Search City's Query Language Capabilities
Search City's query language is very simple and versatile. By respecting a few basic 
principles, you can build precise queries to recover the exact piece of information you need.
Search City provides a set of operators and special symbols used to express different types 
of queries. By combining these elements, you can build very precise or broad queries, 
depending on your requirements.
The simplest type of query is a character string or word search. You can also execute a 
phrase search to look for a sequence of words.
The use of two different wildcards allows you to widen your searches: you can    query for 
words that match a certain prefix, or combine wildcards in order to describe the type of word
you need to find.
You can also use the range symbol to indicate lexicographic limits for a search; the query 
result will contain the words that fall within the specified range.
In addition, you may use the following query language operators:
· and
· or
· not
· ex
· inc
· near
· before
· after
Thanks to the and, or, ex, near, before and after operators, you can precisely indicate 
associations between two different expressions. The not operator selects a set of files that 
do not contain the queried expression. As for the inc operator, it lets you specify the text 
database field you want to focus your search on.



Word Search
The simplest type of query you can make is searching for a single word or character string. 
Suppose that you want to find all instances of the word 'security' in the example group. You 
can do this very easily by typing the following text in the query edit area:

security
When you execute this query with the DEMOFILE.SCG group, Search City returns four hits 
located in four files, that you can examine in the Hit List.
The following are examples of word or character string searches:

user

YMCA

1993
Reserved words must be treated in a special way.

For further information, see:
Word Search with Synonym and Stopword Filters
Upper and Lowercase Characters, Spaces and Punctuation Marks
Reserved Words



Reserved Words
Search City's query language assigns a special meaning to a set of words formed by the 
query language operators and, or,    ex, near, before, after, not and inc. These words are 
called reserved words and must be treated in a special manner.
To appreciate how to use reserved words, try making the following query:

and
This search produces an error message.
Search City considers that the query contains a syntax error: since and is a query language 
operator, it must be associated with the two expressions you want to find. If you need to find
all instances of the word 'and', you must enclose the reserved word in quotation marks, as 
shown below:

"and"
This query produces 211 hits of 'and'.



Phrase Search
Search City allows you to make searches of two or more consecutive words, called phrase 
searches. In this case, the phrase must be delimited by quotation marks (simple or double). 
Phrases can have up to 255 consecutive characters, including spaces between words and 
quotation marks. The following example corresponds to a phrase search:

"account management"
This query finds two instances of 'account management'.
These are other examples of phrase searches:

"Good morning"

"One, two, three and four"

"She arrived way past seven o'clock"

"I got married in 1966"
You can also look for phrases that have quotation marks in the group's texts, using the 
backslash as an escape character (\), as long as quotation marks have been defined as part 
of word characters in the character filter. The following example searches for a phrase with 
quotation marks and returns instances of the phrase, regardless of the type of quotation 
marks used (simple or double).

If you include the wildcards '*' and '?' within a phrase enclosed in quotation marks, 
they will be considered as ordinary characters. In consequence, a query such as "how 
are you?" will be treated as a simple phrase search and will return all instances of the 
phrase 'how are you?' located in the group's texts.

For further information, see:
Word Search with Synonym and Stopword Filters
Upper and Lowercase Characters, Spaces and Punctuation Marks



Upper and Lowercase Characters, Spaces and Punctuation Marks
When you execute searches, Search City does not consider differences in case, number of 
spaces between words or punctuation marks. This occurs because you are applying the 
DEFAULT.NRL character filter, provided with the application. The ability to determine which 
characters are relevant and which aren't is one of the most interesting characteristics of the 
character filters. For example, the search:

commercial
generates a set of hits containing instances of 'commercial' and 'Commercial'. 
Each time Search City comes across one or more characters that are not part of a word, it 
replaces them with a blank space. Both the group's texts and the query expression are 
filtered, so a search such as:

"benefits, etc."
generates the same result as the search:

"benefits etc"



Word Search with Synonym and Stopword Filters
Synonym and stopword filters are optional filters you can use to increase your text retrieval 
capabilities.
A synonym filter corresponds to a list of words with their synonyms. During filtering, all the 
synonyms are treated as equivalent expressions, as if they were the same word.
If you apply the DEMO.SYN synonym filter to the DEMOFILE.SCG group, and you execute the 
following search:

software
you will see that the selected hits correspond to all the synonyms of the word 'software', 
such as 'application', 'product', 'information systems' and 'operating systems'.
In addition, if you search for one of software's synonyms, as: 

"information systems"
Search City will select the same hits it returned when you executed the previous search.
Likewise, the stopword filter corresponds to a list of character strings, words or phrases that 
are irrelevant in the search context. Search City ignores all the stopwords    present in your 
group texts and queries. 
If you apply the ENGLISH.STW filter to the DEMOFILE.SCG group, you can try the following 
query to see the effect of this filter:

"the banking operations"
When you execute this query, Search City finds two instances of the phrase 'banking 
operations', since 'the' has been defined as a stopword, and therefore it is ignored during 
the search.



Searches with Special Symbols
By using the symbols '*', '?' and '..' you can make special searches with Search City. The 
asterisk (*) and the question mark (?) are wildcards and you can use them to execute prefix 
and wildcard searches. The two periods (..) serve for executing range searches.



Prefix Search
Suppose you need to find all the instances of words that begin with a given sequence of 
characters, as those that begin with 'com', like 'computer', 'commerce', 'companies', etc. 
In Search City,    you can do this by executing the query:

com*
This is called a prefix search. The '*' is a wildcard and when placed at the end of a string of 
characters, it represents any sequence of zero or more characters.
Any sequence of characters can be a prefix. The following are examples of simple prefixes:

dif*

histor*

institut*

The asterisk only matches those characters that have been defined as part of word 
characters in the character filter.

If the prefix that forms part of the search is a reserved word, it is necessary to enclose it in 
quotation marks as in the following case:

"inc"*
Here, quotation marks serve to indicate that 'inc' is no being used as a reserved word, and 
thus allowing you to find instances of words such as 'include', 'increase' and 'incorporate'.
You can also use a phrase as a prefix, as in the query:

"its co"*
Just like in the standard case, you must enclose the phrase in quotation marks.



Wildcard Search
There are two types of wildcards in Search City. The first is the asterisk (*) that matches zero
or more characters. The second is the question mark (?) which matches any sole character.
Suppose you wish to find all the words that begin with a 'p' and end with an 'e'. In this case, 
you must execute the query:

p*e
On the other hand, you can use the '?' wildcard to determine the length of the word you are 
searching, independently of the specific characters that form the word. The '?' symbol 
always matches any single character, as shown in the following query:

p?????e
This query finds all seven letter words that begin with a 'p' and end with an 'e', such as 
'package' and 'precise'.
It is also possible to combine the '*' and '?' wildcards. For example:

d?*r*e
finds words that begin with a 'd', have an 'r' as the third or more letter and are equal to or 
longer than four characters. Words like 'diverse' and 'degree' meet these requirements.
Search City does not currently support the use of wildcards as the first character in a word, 
so a search such as:

*tion
will not be executed, and Search City will display a syntax error message.



Range Search
Search City lets you search for words within a given character range by placing the '..' 
symbol between two alphabetical expressions.

open..other
This query returns all the words found within this range, that is, all terms that are equal or 
greater than 'open' and less than or equal to 'other', such as 'options', 'operations' and 'or'.
Range searches work by evaluating the lexicographic order of the expressions defined by 
the range. The query x..y matches all words whose first character is greater or equal to 'x' 
and less than or equal to 'y'.
Range searching is especially useful when you want to find references to ranges of dates or 
numbers. For example:

4..5
The previous query finds all the numbers that fall within the specified range.
Nevertheless, numbers are also evaluated lexicographically, so numerical order is not 
always respected; for example, when the length of the numerical expressions is different.
Suppose you want to execute the following search:

4..18
In this case, Search City displays an error message since the order of the expressions is 
inverted: in lexicographic order, '18' is smaller than '4'. Therefore, to execute this search you
must type:

18..4



Basic Query Language Operators
Search City's query language basic operators are:
· and
· or
· not
· ex
· inc



And Operator
To understand how Search City's and operator works, you can execute the following query:

commercial and financial
This query generates 16 hits of the words 'commercial' and 'financial' located in two files. 
These two files contain hits of both words, since the and operator only returns matches if the
two searched expressions are present in the same file.
On the other hand, the query:

account and report
does not produce any hits, even though these words are present in the group's texts, since 
they do not appear simultaneously in any file.



Or Operator
The or operator is used to search for two different expressions at the same time. For 
example, if you need to find all instances of the words 'management' and 'administrative', 
you can execute the query:

management or administrative
The 27 hits returned by Search City are distributed in nine files.
If you execute the query:

client or patient
Search City returns a set of hits of both words. Note that in this case, the matches of 'client' 
are in some files and those of 'patient' are in others. This indicates that the or operator acts 
as an 'inclusive OR', that is, it finds all instances of either or both expressions specified in 
the search. These expressions don't necessarily have to be in the same file, as occurs with 
the and operator.
For this reason, if you search for:

disk or drive
Search City successfully executes the query: it matches 'disk' but doesn't return any 
matches of 'drive' since the word 'drive' does not exist in the group's texts.



Not Operator
The not operator returns a set of files that don't contain the expression specified by the 
query. It does not generate any marks. For example, the query:

not medical
selects all the group's files that do not contain the word 'medical'. To see the result of the 
query, you can use the File List:
A query such as:

not information
does not return any files, since all the files associated with the DEMOFILE.SCG group contain 
at least one instance of the word 'information'.



Ex Operator
With the ex operator, you can tell Search City to exclude from the result of a query all files 
containing any matches of a given expression.
Suppose you are initially interested in finding all the words that begin with 're' and you 
execute the following query:

re*
Search City produces 102 marks that match the query, located in all the group's files.
You can observe that the set of hits includes many instances of the word 'records'. If you are 
not interested in this word, you can execute the following query:

re* ex records
The result of this query corresponds to all the words that begin with 're' except those located
in all the files that contain instances of the word 'records'. In other words, Search City finds 
all the matches of the first expression only in the files that don't contain the second 
expression.
If you examine the Hit List, you will note that several words that had been selected by the 
first query, such as 'restrict', 'read' and 'reprinting', do not form part of the hits returned by 
the second query, since they belong to the files excluded by the ex operator.



Inc Operator
If you are working on a text database, you can use an additional operator that is not 
available in when working with simple file groups. It is the inc operator, used to focus 
searches on a specific field. 
Suppose that you are interested in finding instances of the word 'system', but only if they 
are located in the document titles. To do so, you can execute the query:

title inc system
The basic syntax for this type of search is:

<field_name> inc <expression> 
where:
· field_name is the name of any of the text database's fields
· expression is the character string you wish to find. It cannot contain another inc operator.



Distance Searches
Distance searches are one of the most useful and powerful types in Search City's query 
language, since they allow you to retrieve information within a semantic context. In other 
words, you can look for meanings rather than for specific patterns.
This is particularly true when you are searching for inter-related words or phrases and when 
you simply can't remember exactly what you are looking for. 
With distance searches, you find words located near one another, specifying the required 
distance between them as well as their order of appearance. Thus, you can search for 
concepts by querying for the words involved in their definition. 
The concept you need to find may be defined with words or phrases that are distant in the 
group's texts. In this case, you will have to specify broad searching limits to come up with 
the required instances. In other cases, you might need to work within a reduced searching 
range in order to aim precisely at the text you have in mind, excluding general responses.
The distance between two words is defined as the number of characters separating their 
initial letters. For example, the distance between the words 'Oxford' and 'Dictionary' in the 
phrase 'Oxford English Dictionary' is 14 characters.
The distance value can go from 1 to 30000. Search City works with a default value of 60, but
you can Modify the Distance Value according to your needs.

You can find information about the following topics:
Near Operator
Before and After Operators
Using the Not Operator in Distance Searches
Nesting Distance Operators



Modify the Distance Value
You can modify the distance value:
· With the Distance command from the Options menu.
· Including the desired value of distance in a specific query. In this case, it is a temporary 

change that only affects the specified operator. 

To modify the general distance value
1. From the Options menu, choose Distance.

Search City displays the Distance dialog box.
2. Type a distance value.
-Or-

Use the arrows to select a value.
Distance can be defined among 1 and 30000.

3. Choose the OK button.
Search City closes the dialog box and the specified value becomes the standard distance 
applied to distance searches from now on.
If you type an incorrect value, Search City returns an error message specifying the 
minimum and maximum values accepted.

To modify the distance value temporarily
You can temporarily modify the value of distance. To do so, you can include a distance 
specification within the query itself.

access near:220 information before:15 tasks
In this case, the near operator works with a distance value of 220 while the before operator 
works with a value of 15.
Now, If you execute the query:

access near:220 information before tasks
you tell Search City to apply a distance value of 220 to the near operator and the general 
distance value (specified in the Distance dialog box) to the before operator.



Near Operator
You can use the near operator to perform general distance searches, since this operator 
finds two words located near one another, without considering the order in which they 
appear.
For example, if the value of distance is 60 and you execute the query:

access near information
Search City finds five matches of the word 'access' near the word 'information': four of them 
correspond to instances of 'access' before 'information' and one to 'information' before 
'access'.



Before and After Operators
You can use the before and after operators to pinpoint your search without reducing its 
breadth, that is, for searches where the general order of retrieval is important.
X before Y searches for all instances of X found before Y, whereas X after Y returns all 
instances of X located after Y.
The following examples illustrate how these operators work:

microcomputers after compatible
This query returns the following set of hits:
If you execute the query:

compatible before microcomputers
you will get exactly the same matches.
As with the near operator, you can modify the value of distance with the Distance command 
or directly in a query, like in the following case:

microcomputers after:15 compatible



Using the Not Operator in Distance Searches
By combining the not operator with the distance operators near, before and after, you can 
search for concepts defined by the exclusion of a given word or phrase. To do so, you use the
operators not near, not before and not after.
For example, if you search for the instances of the word 'institutions', you will get many 
matches that correspond to the phrase 'financial institutions'. Thanks to the not after 
operator, you can exclude these matches from the query result:

institutions not after financial
For further understanding of how the not operator works in distance searches, try the 
following query:

control not near:200 information
This search allows you to retrieve all the instances of the word 'control' that don't 
correspond to the semantic context of information management.



Nesting Distance Operators
Distance searches can also be nested to focus the search within a wider answer. This feature
is very useful when searching for a concept that can be defined with words that must be 
near one another which in turn are related to a third word or phrase. 
You can execute the query:

systems near:30 records near patient
This query allows you to retrieve the instances of the word 'systems' located within a range 
of 30 characters of the word 'records', which in turn are within the normal distance range of 
the word 'patient'.
Let's see another example. A search in medical literature such as:

hemo* near ("white series" near lymphocytes)
is sufficiently broad to return a variety of instances of 'white series' associated with 
'lymphocytes' that are, in turn, near terms with the prefix 'hemo' (hemophilia, hemogram, 
etc.). On the other hand, such a search will eliminate contexts such as 'white series' and 
'lymphocytes' near hemophilia or hemogram, if they do not fall within the range specified by
the distance parameter.
By subordinating one distance operator to another, it is possible to gradually isolate the 
desired piece of information.



Combining Operators and Other Query Language Elements
If you combine different operators, types of searches and query language symbols you can 
build precise queries to focus on the exact information you need to recover.
Combinations are practically boundless and provide you with very precise searching tools. 
You must simply respect the basic norms established for general searches and each operator
or symbol, which have been treated in previous chapters. In addition, you must remember 
that Search City evaluates the different operators in a determined order, which means that it
assigns them a certain precedence. Nevertheless, you can modify precedence by using 
parentheses to group certain expressions.

For further information, see:
Operator Precedence
Parentheses
Examples of Query Combinations



Operator Precedence
The following lists all Search City operators in decreasing order of precedence. In the case of
equal precedence, they are evaluated from the left.

Parentheses
after, before, near, not after, not before, not near
inc
not
and
or, ex



Parentheses
Parentheses can be used in Search City to define the order of evaluation of a query's 
operator or precedence, as well as to group expressions or parts of expressions together. 
The expressions in parentheses    are always evaluated first.
To see how this works, execute the following query:

physician or patient and record
The result corresponds to 12 hits located in three files. Now you can try the query:

(physician or patient) and record
In this case, the result in formed by 5 hits found in one single file. The reason for this 
difference is that the and operator has precedence over the or operator, except if you use 
parentheses to alter the evaluation order. In the first query, Search City selects the instances
of 'patient' and 'record' located in the same files and then adds to the list of hits all 
instances of the word 'physician', wherever they are in the group's files. In the second query,
on the other hand, Search City first retrieves all the instances of the words 'physician' and 
'patient' and then selects only the matches of these words found in files that also contain 
instances of the term 'record'.
Parentheses can also help you formulate queries more clearly, even if you do not intend to 
modify evaluation order.
In the simplest case, you could execute a query such as:

(reports)
This is correct syntax, equivalent to the query:

reports
Similarly, you can execute the query:

(banking and credit) and "financial institutions"
This query returns 6 hits from one single file. Parentheses are not necessary in this case 
since the query only uses the and operator. Therefore, though the sub-queries: 

banking and credit
and

credit and "financial institutions"
have equal precedence, Search City evaluates the sub-query banking and credit first, 
since this query is the first from left to right, it has mayor precedence. 



Examples of Query Combinations
Now we present an overview of some basic operator and special symbol combinations you 
can use to build different types of queries. These examples don't pretend to show you all the
actual query combinations; they should simply serve so you can get an idea of the great 
versatility of Search City's query language. As for the rest, it is up to you to try!

"medical record"*

"current accounts" or banks

refunding and "international commerce"

summary inc "computer technology"
(this query only applies to text database searching)

not "medical laboratory"

"health care" near system

e*p*e or e*t*e

not (communicat* and on-line)

medic* near patients

person* not before credit 

access near:30 (information or control)

database and system* or data and software

description inc (administ* or management) ex title inc medical

not (sales and purchasing)

acc* before pay*



Commands
New Command (File Menu)
Create File Group Dialog Box
Browse Dialog Box
Create Text Database Group Dialog Box
Open Command (File Menu)
Close Command (File Menu)
Properties Command (File Menu)
Group Files Command (File Menu)
Mark Files Dialog Box
Unmark Files Dialog Box
Hidden Extensions Dialog Box
Index Command (File Menu)
Exit Command (File Menu)
Cut Command (Edit Menu)
Copy Command (Edit Menu)
Paste Command (Edit Menu)
Add Text Command (Edit Menu)
Mark File/Document for Delete (Edit Menu)
Unmark File/Document for Delete (Edit Menu)
Hits Command (View Menu)
Next Hit Command (View Menu)
Previous Hit Command (View Menu)
Files Command (View Menu)
Documents Command (View Menu)
Next File/Document Command (View Menu)
Previous File/Document Command (View Menu)
Queries Command (View Menu)
Subjects Command (View Menu)
Rename Subject Dialog Box
Filters Command (Utilities Menu)
Create Character Filter Dialog Box
Modify Character Filter Dialog Box
Save As Dialog Box
Check Command (Utilities Menu)
Pack Command (Utilities Menu)
Distance Command (Options Menu)
Full Index Command (Options Menu)
Wrap Command (Options Menu)
DOS Text Command (Options Menu)
Fonts Command (Options Menu)
Auto Show Hits Command (Options Menu)
Use Default Directory Command (Options Menu)



New Command (File Menu)
Use this command to specify the type of group you want to create. Later, you will define the 
group properties.
New Group Dialog Box Options
Group Type

You can create a group of plain text (File Group) or a textual database (Text Database 
Group).

OK
This button opens the Create File Group Dialog Box or Create Text Database Group Dialog 
Box, depending on the type of group specified. In these dialog boxes, you can indicate the
new group's basic properties (filename, path, description and filters; and, in the case of a 
text database, its field and document structure).

See:
Create a File Group Definition
Create a Text Database Group Definition



Create File Group Dialog Box
In this dialog box, specify the group's basic properties.
Dialog Box Options
File Name

Type a name for the new group and, optionally, a file path. You can also provide this 
information by clicking the Browse button, which opens the Browse dialog box.

Description
Type a sentence to identify the group. This is optional information.

Filters
Select a character filter from the list of available filters. You can also select a synonym 
filter and/or a stopword filter. 

Browse Button
Opens the Browse dialog box, which displays a directory tree so you can select the 
directory for saving the new group.

OK Button
Saves the new group definition and opens the Group Files dialog box, so you can select 
the files you want to add to the group.

See:
Create a File Group Definition



Browse Dialog Box
You can open this dialog box with the Browse button on the New Group dialog box. It allows 
you to specify the new group's filename and path.
Dialog Box Options
Drives

Select a disk drive. 
Directories

Double-click a directory to select it.
File Name

Type a name for the new group.

See:
Create a File Group Definition
Create a Text Database Group Definition



Create Text Database Group Dialog Box
In this dialog box, specify the new group's basic properties.
Dialog Box Options
File Name

Type a name for the new group and, optionally, a file path. You can also provide this 
information by clicking the Browse button, which opens the Browse dialog box.

Description
Type a sentence to identify the group. This is optional information.

Filters
Select a character filter from the list of available filters. You can also select a synonym 
filter and/or a stopword filter. 

Browse Button
Opens the Browse dialog box, which displays a directory tree so you can select the 
directory for saving the new group.

Doc. Name
Select or type a field name as the document name.

Doc. Recognizer
Type one or more recognizer characters to indicate the beginning of the document in the 
file's text. This is optional information.

Fields
Name: Type all database's field names.
Recognizer: For each field, specify one or more characters for recognizing the beginning 
of the field in the file's text. 

Add Button
Click to add the field -- and its recognizer -- to the text database's list of fields.

Delete Button
Click to delete the selected field from the text database's list of fields. 

OK Button
Saves the new group definition and opens the Group Files dialog box, so you can select 
the files you want to add to the group.

See:
Create a Text Database Group Definition



Open Command (File Menu)
Use this command to open any existing    group.
Open Group Dialog Box Options
File Name

Type or select a group filename.
Directories

Double-click the directory containing the group you want to open.
Drives

Select a disk drive.

See:
Open a Group



Close Command (File Menu)
Use this command to close the active group, if you want to open another group or quit the 
application.

See:
Close a Group



Properties Command (File Menu)
Use this command to modify the active group's basic properties. Search City opens a dialog 
box identical to the one you filled up when creating the group definition, called File Group 
Properties or Text Database Group Properties, depending of the type of group you are 
working on.
File Group Properties Dialog Box Options 
File Name

You can't modify the group's filename or path.
Description

Type a sentence to identify the group. This is an optional field.
Filters

Select a different character filter for the group. You can also select a synonym filter and/or
a stopword filter. 

See:
Modify the Group Definition
Text Database Group Properties Dialog Box Options
File Name

You can't modify the group's filename or path.
Description

Type a sentence to identify the group. This is an optional field.
Filters

Select a different character filter for the group. You can also select a synonym filter and/or
a stopword filter. 

Doc. Name
Select or type a different field name as the document name.

Doc. Recognizer
Type one or more recognizer characters to indicate the beginning of the document in the 
file's text. This is optional information.

Fields
Name: Type all the database's field names.
Recognizer: For each field, specify one or more characters for recognizing the beginning 
of the field in the file's text. 

Add Button
Click to add the field -- and its recognizer -- to the text database's list of fields.

Delete Button
Click to delete the selected field from the text database's list of fields. 

See:
Modify the Group Definition



Group Files Command (File Menu)
Use this command to specify the files you want to add and/or delete from the group.
Dialog Box Options
Current Drive

Select a disk drive.
Directory tree

Select a directory.
Directory

Indicates current directory.
Mark Button

Opens the Mark Files dialog box, where you can specify the files you want to add/delete.
Unmark Button

Opens the Unmark Files dialog box, where you can specify the files you previously marked
that you no longer want to add/delete.

Hide Button 
Opens the Hidden Extensions dialog box where you can indicate all extensions you don't 
want to display in the file list.

See:
Add Files to the New Group
Add Files to an Existing Group
Mark Files for Deletion in the Group Files Dialog Box



Mark Files Dialog Box
Use this dialog box to specify the files you want to add/delete. To open the dialog box, click 
the Mark button from the Group Files dialog box.
Dialog Box Options
File Specification

Type a filename.
Search in Subdirectories

Select this option to mark all files located in the subdirectories depending on the current   
directory.

Mark for
Select the Add option to mark a file you want to add to the group and the Delete option 
to mark a file you want to delete from the group.

See:
Group Files Command (File Menu)



Unmark Files Dialog Box
Use this dialog box to specify the marked files you no longer want to add/delete. To open the
dialog box, click the Unmark button from the Group Files dialog box.
Dialog Box Options
File Specification

Type a filename.
Search in Subdirectories

Select this option to unmark all files located in the subdirectories depending on the 
current    directory.

Unmark for
Select the Add option to remove marks from files marked to add and the Delete option 
to remove marks from files marked for delete.

See:
Group Files Command (File Menu)



Hidden Extensions Dialog Box
Use this dialog box to specify all the extensions you don't want to display in the Group Files 
dialog box.    To open the dialog box, click the Hide button from the Group Files dialog box.
Dialog Box Options
Extensions

Type the extensions you don't want to see in the file list, including a period (for 
example, .PM4). The list of hidden extensions is displayed.

Add Button
Click to add the extension from the Extension box to the list of hidden extensions.

Remove Button
Click to remove the extension from the Extension box from the list of hidden extensions.

See:
Group Files Command (File Menu)



Index Command (File Menu)
Use this command to index the current group. When the indexing procedure is over, Search 
City displays a dialog box informing you that the index has been created or updated.

See:
Manage the Group Index



Exit Command (File Menu)
Use this command to quit the application.

See:
Quit Search City



Cut Command (Edit Menu)
Use this command to remove selected text and put it on the Clipboard. This command is 
unavailable if you have no selected text. Cutting text to the Clipboard replaces the contents 
previously stored there.

See:
Copy Command (Edit Menu)
Paste Command (Edit Menu)



Copy Command (Edit Menu)
Use this command to copy selected text onto the Clipboard. This command is unavailable if 
you have no selected text. Copying text to the clipboard replaces the contents previously 
stored there.

See:
Cut Command (Edit Menu)
Paste Command (Edit Menu)



Paste Command (Edit Menu)
Use this command to insert a copy of the Clipboard contents at the insertion point. This 
command is unavailable if the Clipboard is empty.

See:
Cut Command (Edit Menu)
Copy Command (Edit Menu)



Add Text Command (Edit Menu)
Use this command to add documents to the current text database.

This command is only available when you are working on a text database group.

Add Text Dialog Box Options
Document

Type the new document's contents, entering text in any of the text database's fields.
Documents Added

Indicates the number of documents you have added since you opened the dialog box.
Add Button

Click to add the document you just entered to the text database.
Clear Button

Click to clear the dialog boxes' contents so you can enter another document text.

See:
Add Documents to a Text Database



Mark File/Document for Delete (Edit Menu)
Use this command to mark for delete the file/document displayed in the text area. The 
status bar shows when a file/document is marked for delete. Next time you choose the Pack 
command, Search City will remove all marked files/documents from the group.

See:
Delete Files from the Group



Unmark File/Document for Delete (Edit Menu)
Use this command to remove the current file/document's deleting mark. The status bar 
indicates that the file is no longer marked for delete.

See:
Delete Files from the Group



Hits Command (View Menu)
Use this command to display the Hit List, which lists all hits returned by your last query.

This command is only available when you have already executed a query. 
You can also open the Hit List with the Hits button on the navigation bar. When you 
select the Auto Show Hits option on the Options menu, Search City automatically 
displays the Hit List after each query. 

Hit List Dialog Box Options
nº Hits in nº Files/Documents

This message indicates the total number of hits returned by your last query as well as the
total number of files/documents where these hits are located.
The list box under the message displays the list of hits so you can select one.

Hit Context
Displays the immediate textual context of the selected hit.

File/Document
This message indicates the filename or document name containing the selected hit. In 
the case of a file, it also indicates its complete file path.

OK
Displays the selected hit in the text area.

See:
Review Query Results Through the Hit List
Display the Hit List Automatically After Each Query



Next Hit Command (View Menu)
Selects and displays the next hit from the list of hits. The Next Hit button from the 
navigation button performs the same action.

See:
Examine Hits One by One in Their Textual Context



Previous Hit Command (View Menu)
Selects and displays the previous hit from the list of hits. The Previous Hit button from the 
navigation button performs the same action.

See:
Examine Hits One by One in Their Textual Context



Files Command (View Menu)
Use this command to display the File List dialog box, which contains the list of all the files 
selected by the last query.

You can also display the File List by clicking the Files button from the navigation bar.
When working with a text database, this command is called Documents.

File List Dialog Box Options
File List Hits

This list box displays all the files selected by your last query indicating the number of hits 
per file.

Full Path
Indicates the selected file's path.

OK
Displays the selected file in the text area.

See:
Review Query Results Through the File List
Documents Command (View Menu)



Documents Command (View Menu)
Use this command to display the Document List dialog box, which lists all the documents 
selected by the last query.

You can also display the Document List by clicking the Files button from the navigation
bar.
When working with a group of simple files, this command is called Files.

Document List Dialog Box Options
Document List

This list box displays all the documents selected by your last query.
Detail

Displays the selected document's full name.
File

Indicates the file where the selected document is stored.
Document

Indicates the document number.
OK

Displays the selected document in the text area.

See:
Review Query Results Through the File List
Files Command (View Menu)



Next File/Document Command (View Menu)
Selects and displays the next file/document from the list of files/documents selected by your
last query. This command is functionally equivalent to clicking the Next File button on the 
navigation bar.

See:
Examine Files One by One in the Main Window



Previous File/Document Command (View Menu)
Selects and displays the previous file/document from the list of files/documents selected by 
your last query. This command is functionally equivalent to clicking the Previous File button 
on the navigation bar.

See:
Examine Files One by One in the Main Window



Queries Command (View Menu)
Use this command to open the History dialog box, which lists the last 99 queries you have 
executed. Your last query is selected.

You can also open the History dialog box by clicking the Queries button on the toolbar.

History Dialog Box Options 
Query List

This list box displays the last 99 queries you have executed.
Detail

This box displays the selected query's complete text. It also specifies if the query has 
been executed using a selector, indicated in the Selector box.

Files/Docs
Indicates the number of files/documents selected by the current query.

Hits
This message informs you about the number of hits returned by the selected query.

Search Button
Executes the selected query.

Edit Button
Places the selected query text in the query edit area so you can edit it before executing 
the query.

See:
Use Previous Queries by Displaying the History List



Subjects Command (View Menu)
Use this command to display the Subjects dialog box, which displays all the subjects you 
have defined for the current group.

You can also open the Subjects dialog box by clicking the Subjects button on the 
toolbar.

Subjects Dialog Box Options
Subjects

This list box displays all the subjects that have been defined for the current group.
Detail

This box displays the query associated with the selected subject. The Selector box 
indicates if the query was executed using a file selector.

Search Button
Executes the selected subject.

Edit Button
Places the selected subject in the query edit area so you can edit it before executing the 
query.

Delete Button
Deletes the selected subject from the list of available subjects.

Rename Button
Click this button to open the Rename Subject dialog box so you can rename the selected 
subject.

See:
Rename Subject Dialog Box
Create a Subject
Execute a Subject
Edit a Subject
Use Subjects to Limit the Search Universe
Rename a Subject
Delete a Subject



Rename Subject Dialog Box
Use this dialog box to rename the selected subject. You can open this dialog box by clicking 
the Rename button on the Subjects dialog box.
Dialog Box Options
Subject Name

This box displays the subject's current name. Type a new name for the subject.

See:
Rename a Subject
Subjects Command (View Menu)



Filters Command (Utilities Menu)
Use this command to create, modify and delete filters.
Filters Dialog Box Options
Type

Select the type of filter option required: character filter, synonym filter or stopword filter.
Filter Filenames

This box displays all the available filters corresponding to the selected type of filter 
option. Type a new filter filename or type or select any existing filter filename.

Edit Button
Click this button to edit the filter specified in the Filter Filenames box. You can use it to 
create a new filter as well as to modify any existing one.

Delete Button
Deletes the filter specified in the Filter Filenames box.

See:
Create Character Filter Dialog Box
Modify Character Filter Dialog Box
Create a Character Filter
Modify a Character Filter
Create Synonym and Stopword Filters
Modify Synonym and Stopword Filters
Synonym and Stopword Filter Syntax
Delete Filters



Create Character Filter Dialog Box
In this dialog box, you specify the new character filter's settings.
Dialog Box Options
Filter

Indicates the new character filter's filename and path. You cannot modify this field's 
contents.

Description
Type a sentence to identify the new character filter.

Char.
Click any character from the character map to select it. The Char. box displays the 
selected character and its character set code.

Map
When you select a character from the character map, this box displays its character 
equivalence. Type a new character equivalence and Search City displays its character set 
code.

Type
When you select a character from the character map, this box displays its character type 
definition: Part of Word, if the character has been defined as a valid character; Join of 
Word, if the character is used to join two words, in which case it will be suppressed during
indexing; or None, if you want Search City to consider the selected character as a word 
separator or blank space. Select the desired option.

Accept Button
You must click this button each time you modify any character definition. Otherwise, you 
lose character map modifications.

Save As Button
Click this button to save the current filter with a different name from that indicated in the 
Filter box.

Set Default Button
Click this button to reestablish the default character filter definition.

Case Sensitive
Select this option if you want the filter to match cases in your texts. When this option is 
not selected, upper and lowercase letters are considered equivalent.

See:
Filters Command (Utilities Menu)
Create a Character Filter



Modify Character Filter Dialog Box
In this dialog box, you can modify any of the selected filter's settings.
Dialog Box Options
Filter

Indicates the selected character filter's filename and path. You cannot modify this field's 
contents.

Description
Type a sentence to identify the character filter.

Char.
Click any character from the character map to select it. The Char. box displays the 
selected character and its character set code.

Map
When you select a character from the character map, this box displays its character 
equivalence. Type a new character equivalence and Search City displays its character set 
code.

Type
When you select a character from the character map, this box displays its character type 
definition: Part of Word, if the character has been defined as a valid character; Join of 
Word, if the character is used to join two words, in which case it will be suppressed during
indexing; or None, if you want Search City to consider the selected character as a word 
separator or blank space. Select the desired option.

Accept Button
You must click this button each time you modify any character definition. Otherwise, you 
lose character map modifications.

Save As Button
Click this button to save the current filter with a different name from that indicated in the 
Filter box.

Set Default Button
Click this button to reestablish the default character filter definition.

Case Sensitive
Select this option if you want the filter to match cases in your texts. When this option is 
not selected, upper and lowercase letters are considered equivalent.

See:
Filters Command (Utilities Menu)
Modify a Character Filter



Save As Dialog Box
In this dialog box, you can specify a new name for the current filter.
Dialog Box Options
Filter Name

Type a new name for the current filter.
See:
Filters Command (Utilities Menu)
Create a Character Filter
Modify a Character Filter



Check Command (Utilities Menu)
Use this command to check the group index status and file composition.
Check Group Dialog Box Options
Status

Indicates the group index status.
Modified Files

Specifies the number of files that have been modified using another application. Search 
City includes all modifications the next time you index the group.

Missing Files
Indicates the number of files reported missing by Search City (all files that are no longer 
stored in the file path specified when you added the file to the group).

Missing File List
Lists all the filenames of the files considered missing.

Delete Button
Click this button to delete the files reported as missing from the group file composition.

See:
Manage the Group Index
Examine Index Status and Group File Composition



Pack Command (Utilities Menu)
Removes from the group file composition all the files/documents you have marked for 
delete.

See:
Delete Files from the Group
Pack a Group



Distance Command (Options Menu)
Use this command to modify the distance parameter applied to distance searches.
Distance Dialog Box Options 
Distance

Type a new value for the distance parameter. Accepted values go from 1 to 30000.

See:
Modify the Distance Value
Distance Searches



Full Index Command (Options Menu)
When this option is active, Search City generates the whole index, whereas when it is not 
active, it only re-indexes the part of the group index that requires updating.

See:
Manage the Group Index



Wrap Command (Options Menu)
When this option is active, Search City adjusts the width of the text to the space provided by
the text area.

See:
Modify the Look of Text on your Screen



DOS Text Command (Options Menu)
When this option is active, Search City transforms the text displayed in the text area from 
OEM standard (DOS character set) to ANSI standard (Windows character set).

See:
Modify the Look of Text on your Screen



Fonts Command (Options Menu)
Use this command to modify the font and font style used to display text in the main 
window's text area.
Font Dialog Box Options 
Font

Select a font.
Font Style

Select the required font style.
Size

Specify the font size.
Sample

Displays a sample text with the specified character format.

See:
Modify the Look of Text on your Screen



Auto Show Hits Command (Options Menu)
When this option is active, Search City displays the Hit List automatically after each query.

See:
Review Query Results Through the Hit List
Display the Hit List Automatically After Each Query



Use Default Directory Command (Options Menu)
When this option is active, Search City automatically works with the default directory when 
creating or opening groups.



Glossary
Character Filter
Current
Default Directory
Distance
Document
Expression
Field
File
Group
Hits
Index      
Mark
Query
Search
Selector
Stopword
Stopword Filter
Subject
Synonym Filter
Text Database



Character Filter
Customizable character transformation rules that normalize the group's texts as well as the 
queries.
Character filter defines:
· The type of character. Characters may be defined as part of a word (generally, numbers 

and alphabetical letters) or as word-joining characters (for example, a hyphen). Part of 
word characters let you specify the character sequences that are relevant for your 
searches. Word-joining characters will be eliminated during the filtering process. Thanks 
to this feature, Search City will select the instances of 'rename' if you are looking for 're-
name'. Finally, characters that do not belong to these two types are interpreted as word 
separators. Each time Search City encounters one or more of these characters, it replaces
them with a blank space. Thus, they are not taken into account in your searches.

· The character map, which is used to specify character equivalence. These equivalence 
are expressed in the form of a transformation rule for each character. In the simplest 
case, a character is equivalent to itself. More complex equivalence can significatively 
increase text retrieval power.

For example, if you determine that 'ï' is equivalent to 'i', when you search for all instances of 
"naive", Search City will select "naive" as well as "naïve".
In the same way, you can determine equivalences between small and capital letters or 
between normal and accented vowels.
The character filter's standard version provided by Search City (DEFAULT.NRL) has been 
designed to work on normal English text: it is a basic filter with no special character mapping
rules, excepting it is not sensible to differences in case.



Current
Used in association with words like directory, hit, file, etc. to indicate that the given element 
is selected or active.



Default Directory
The default directory contains the application and it called is C:\SEARCHIT. You can modify 
the default directory definition in the SEARCHIT.INI file. 



Distance
A user defined parameter that establishes the search range applied to a distance search, 
measured in number of characters.



Document
Basic text database structure, divided into fields.



Expression
The formal search contents that can be formed by Search City operators and symbols as well
as words, phrases or character strings that you wish to find in the group. The expression 
must be formulated according to the query language syntax.



Field
Structured element that forms part of a document in a text database.



File
Refers to a text file.



Group
User defined search universe. A group is formed by a set of files that can be structured as a 
text database, if required.



Hits
Portions of the group's text (word, phrase, etc.) selected by a query.



Index
Create the group index according to the character, stopword and synonym filters selected by
the user.



Mark
A visual cue that shows a hit in the main window's text area.



Query
Valid expression according to the Search City syntax that indicates the text you want to 
search for.



Search
Basic Search City action executed when you submit a query to the application. Depending 
on the operators and symbols included, you can perform different types of searches.



Selector
In Search City, you can use subjects to restrict the set of files affected by a query. This is 
called using a subject as a selector. It means that when you execute a query, Search City 
only looks for the queried expression in the files selected by the selector -or subject. Use the
Subject box in the toolbar to specify a selector.



Stopword
Words defined as irrelevant in the textual context in which the user executes queries (for 
example, the articles in a sentence).



Stopword Filter
Transformation rules applied to the group's texts and queries that specify the words or 
expressions the user wishes to ignore during searches.
In Stopword filter files, you store a list of character sequences, words or phrases you want 
Search City to ignore. In this case, all expressions stored in this file will be considered as a 
blank space.



Subject
A query saved for permanent use. When you execute a subject, Search City selects the files 
that meet the specified conditions, so subjects allow you to classify information.



Synonym Filter
Transformation rules applied to the group's texts and queries that specify the words or 
character strings that Search City must treat as identical expressions.
The filter has the form of a list of character sequences, words or phrases with all their 
equivalency alternatives, stored in a text file. For example, suppose you define that 'United 
States of America', 'America' and 'USA' are synonyms. When you search for instances of 
'USA', Search City returns a set of hits containing instances of the three expressions; the 
same hits Search City will return if you search for instances of 'America'.



Text Database
Text files gathered in a group divided into fields and documents.



Distance Searches
Query Language / Distance Searches
Query Language / Using the Not Operator in Distance Searches



default directory
Commands / Use Default Directory Command (Options Menu)
Glossary / Default Directory



text database
How To... / Create a Text Database Group Definition
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Glossary / Text Database
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